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APLICACIONES ADICIONALES PARA SU NOKIA N70

En el paquete de ventas encontrara la tarjeta multimedia de tamafio reducido
con doble voltaje (RS-MMC, Reduced-Size Dual Voltage MultimediaMemoryCard)
que contiene aplicaciones adicionales de Nokia y desarrolladores a terceros.

El contenido de la RS-MMCy la disponibilidad de las aplicaciones y servicios
podrian variar por pais, minorista y/ o operador de red. Las aplicaciones

e informacion mas detallada sobre el uso de las aplicaciones estan disponibles
en http://latinoamerica2.ext.nokia.com/mitelefono sélo en los idiomas
seleccionados.

Algunas operaciones y funciones dependen de la tarjeta SIM y/o red, MMS

o compatibilidad de dispositivos y los formatos de contenido admitidos.
Ciertos servicios estan sujetos a un cargo por separado.

SIN GARANTIA

Las aplicaciones provistas en la tarjeta Multimedia de Tamafio Reducido con Doble
Voltaje (RS-MMC) han sido creadas y pertenecen a personas o entidades que no son
afiliadas a / o relacionadas con Nokia. Nokia no es el propietario de los copyrights o
derechos de propiedad intelectual a estas aplicaciones a terceros. Por lo tanto, Nokia
no asume responsabilidad por cualquier soporte al consumidor o por la funcionalidad
de estas aplicaciones, ni por la informacion presentada en las aplicaciones o en estos
materiales. Nokia no provee ninguna garantia para estas aplicaciones.

USTED RECONOCE EL SOFTWARE Y/O LAS APLICACIONES (COLECTIVAMENTE,

EL "SOFTWARE") SON PROVITOS “TAL CUAL" SIN GARANTIA DE CUALQUIER TIPO
EXPRESADA O IMPLICITA'Y A LA EXTENSION MAXIMA PERMITIDA POR LA LEY
APLICADA. NI NOKIA NI SUS AFILIADOS HACEN REPRESENTACIONES O GARANTIAS
ALGUNA, SEAN EXPRESADAS O IMPLICITAS, INCLUYENDO PERO SIN LIMITARSE A,
GARANTIAS DE TiTULO, MERCADEO O CAPACIDAD PARA UN PROPOSITO PARTICULAR
0 QUE EL SOFWARE NO INFRINJA CUALQUIER PATENTE, COPYRIGHT, MARCAS
REGISTRADAS U OTROS DERECHOS A TERCEROS. NO HAY GARANTIA PROVISTA POR
NOKIA O POR SUS AFILIADOS QUE NINGUN ASPECTO DEL SOFTWARE CUMPLIRA SUS
REQUISITOS O QUE EL FUNCIONAMIENTO DEL SOFTWARE SERA ININTERRUMPIDO
O LIBRE DE ERRORES. USTED ASUME TODA RESPONSABILIDAD Y RIESGO AL
SELECCIONAR EL SOFTWARE PARA OBTENER SUS RESULTADOS ESPERADOS Y POR
LA INSTALACION, USO Y RESULTADOS OBTENIDOS DE ESTE. EN LA MEDIDA MAXIMA
PERMITIDA POR LAS LEYES APLICABLES, EN NINGUN CASO NOKIA, SUS EMPLEADOS
0 AFILIADOS SERAN RESPONSABLES POR NINGUN LUCRO CESANTE, PERDIDAS DE
INGRESOS, VENTAS, DATOS, INFORMACION O COSTOS DE ADQUISICION PARA

SUSTITUIR BIENES O SERVICIOS, DANO A LA PROPIEDAD, DANO PERSONAL,
INTERRUPCION DE NEGOCIOS O POR CUALQUIER DANO ESPECIAL DIRECTO O
INDIRECTO, INCIDENTAL, ECONOMICO, COBERTURA, PUNITIVO, DANOS ESPECIALES
0 CONSECUENTES, SIN IMPORTAR COMO SUCEDIERON O SI OCURRIERON BAJO
CONTRATO, AGRAVIO, NEGLIGENCIA U OTRA TEORIA DE RESPONSABILIDAD QUE
SURJA DEL USO O LA INCAPACIDAD DE USAR EL SOFTWARE AUN CUANDO NOKIA
0 SUS AFILIADOS HAYAN SIDO NOTIFICADOS DE LA POSIBILIDAD DE DICHOS DANOS.
PUESTO QUE ALGUNOS PAISES/ESTADOS/JURISDICCIONES NO PERMITEN LA
EXCLUSION DE LIMITACIONES DE RESPONSABILIDAD ANTERIORMENTE MENCIONADA,
PERO PODRIAN PERMITIR QUE LA RESPONSABILIDAD SEA LIMITADA, EN TALES
CASOS, LA RESPONSABILIDAD DE NOKIA, SUS EMPLEADOS O AFILIADOS SE LIMITARA
A $50 DOLARES AMERICANOS. NINGUNA DE LA INFORMACION INCLUIDA EN ESTE
ACUERDO DEBERIA PERJUDICAR LOS DERECHOS ESTATUARIOS DE NINGUNA PARTE
COMO CONSUMIDOR.

COPYRIGHT © 2005—2006 NOKIA. TODOS LOS DERECHOS RESERVADOS.
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DE NOKIA CORPORATION.
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Introduccion

Numero de modelo: Nokia N70-5.
De ahora en adelante denominado Nokia N70.

Su Nokia N70 es un dispositivo multimedia poderoso

e inteligente. Hay varias aplicaciones provistas por Nokia
y diferentes desarrolladores de software de terceros que
le ayudaran a obtener mas provecho de su Nokia N70.

Algunas de las aplicaciones proporcionadas estan en
la tarjeta de memoria multimedia de tamafio reducido
(Reduced-Size MultimediaCard) y algunas estan en

el CD-ROM suministrado con el dispositivo.

La disponibilidad de las aplicaciones pueden variar segun
el pais o zona de ventas.

Para usar ciertas aplicaciones, debera aceptar los términos
de la licencia aplicable.

A través de este documento, los iconos indican si la
aplicacion esta disponible en la tarjeta de memoria ([m))
o CD-ROM ((=)).

g Nota: siretira la tarjeta de memoria, las aplicaciones
instaladas en la tarjeta de memoria no se pueden
utilizar. Vuelva a insertar la tarjeta de memoria
para acceder a las aplicaciones.

g Nota: antes de usar las aplicaciones del CD-ROM,
debera instalarlas en una PC compatible.

Servicios de red

Para usar el dispositivo debera estar suscrito con un proveedor
de servicios moviles. Muchas de las funciones en este
dispositivo dependen de la funcionalidad de su red celular.
Es posible que estos servicios de red no estén disponibles
en todas las redes o bien debera hacer arreglos especificos
con su proveedor de servicios antes de utilizar los servicios
de red. Es posible que su proveedor de servicios le entregue
instrucciones adicionales sobre como utilizarlos y le indique
qué cargos son aplicables. Algunas redes pueden tener
limitaciones que inciden en el uso de los servicios de red.
Por ejemplo, es posible que algunas redes no admitan todos
los servicios y caracteres de idiomas.

Soporte

Las aplicaciones provistas por desarrolladores de software
de terceros tienen soporte de estos desarrolladores. En
caso de problemas con una aplicacion, solicite el soporte
del sitio Web correspondiente. Consulte los enlaces Web
al final de cada aplicacion en esta guia.



Visual
7] Servicio KODAK Mobile m
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KODAK Mobile le permite guardar imagenes y videos en
www.kodakmobile.com y solicitar las impresiones para
que le sean entregadas en casa, asi como también
compartir fotos usando su explorador del dispositivo.

G

Pulse & y seleccione Imaging > KODAK Mobile.

Nota: esta aplicacion sdlo esta disponible en una
cantidad limitada de idiomas.

Para usar el Servicio KODAK Mobile, debera contar con un
punto de acceso que le permita conectarse a la Internet
configurado en su dispositivo. Para obtener mas informacion
sobre puntos de acceso, consulte el manual del usuario de
su dispositivo.

Guardar fotos y videos

Desplacese a través de la lista y pulse (8) para marcar la
imagen o video actualmente seleccionado. Para eliminar la

marcacion de un elemento, pulse(®) en un elemento marcado.

Cuando todas las foto y videos que desea guardar estén
marcados, seleccione Opciones > Guardar. Los elementos
seran cargados en el Servicio KODAK Mobile Service, consulte
"Crear una cuenta del Servicio KODAK Mobile", pag. 5.

Los archivos guardados en el Servicio KODAK Mobile son
automaticamente ubicados en un album que podra ver
en www.kodakmobile.com usando el explorador de su
dispositivo 0 en una PC compatible.

Las fotos y videos que estan marcados con la "K" de Kodak

en la lista del teléfono han sido guardados correctamente.

Crear una cuenta del Servicio
KODAK Mobile

Para hacer una conexion al Servicio KODAK Mobile, se le
solicitara que seleccione un punto de acceso para conectarse
a la Internet. Para cambiar el punto de acceso en otro
momento, seleccione Opciones > Configuraciones.
Cuando se haya conectado a la Internet, se le solicitara
registrarse a un Servicio de KODAK Mobile, Kodak EasyShare
Gallery o Ofoto.com. con una cuenta existente. En caso de
no tener una cuenta, puede registrarse para obtenerla.

1 Ingrese su numero telefonico (incluyendo el codigo
internacional del pais) y una contrasefa. Si se esta
registrando a una cuenta que ya existe, se le solicitara
que ingrese su direccion de e-mail.

2 Seleccione su operador de red celular de la lista.

Sus fotos y videos son guardados en el Servicio Kodak
Mobile. En conexiones posteriores, sera automaticamente
conectado a su cuenta.
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Solicitar impresiones

Seleccione las imagenes que desea imprimir. Cuando todas
estas estén marcadas, seleccione Opciones > Order prints.
Los elementos son guardados en el Servicio KODAK Mobile
Service en www.kodakmobile.com. Para completar los
detalles de su solicitud de impresion, conéctese al Servicio
KODAK Mobile Service usando el explorador de su dispositivo.
Por razones de sequridad, se le podria solicitar que ingrese
el nimero telefonico (incluyendo el cddigo internacional

del pais) y contrasefia que proporciond cuando cred su cuenta.

Las impresiones solicitadas por medio del Servicio KODAK

Mobile seran impresas en papel Kodak y enviadas a su casa.

Compartir

Marque las fotos que desea compartir con sus amigos

y familiares y seleccione Opciones > Compartir. Ingrese
direcciones de e-mail o seleccione direcciones de e-mail
guardadas en contactos. Las fotos se guardan en el Servicio
KODAK Mobile Service y se enviara por e-mail, a las
direcciones que selecciond, una invitacion para ver

los elementos que estan en el servicio.

Solucion de problemas
Recuerde de proporcionar su codigo internacional del pais
cuando se registre en el Servicio KODAK Mobile.

En caso de no poder guardar sus fotos o imagenes, verifique
la informacion de su cuenta del Servicio KODAK Mobile en
el sitio Web www.kodakmobile.com usando el explorador
de Web en su PC. Asegurese de que el numero telefonico
movil, e-mail y contrasefa estén correctos. Guardelos otra
vez y edite su informacidn, en caso de ser necesario.

Si el problema persiste y no puede conectarse al Servicio
KODAK Mobile, confirme con su operador que los servicios
de datos de su dispositivo mévil trabajen apropiadamente.
Debera tener una suscripcion de datos que le permita
acceder a la Internet.

Mas informacion

Puede cambiar como y dénde se guardan automaticamente
los elementos en el sitio Web del Servicio KODAK Mobile.
Para hacer un cambio, consulte www.kodakmobile.com
usando el explorador de Web de su PC y seleccione la
seccion de Mobile Upload Albums de Mi Cuenta.

Puede encontrar mas informacion del Servicio KODAK Mobile
Service en el sitio Web. Consulte www.kodakmobile.com
usando su PC compatible o su dispositivo.

Si tiene problemas con el Servicio KODAK Mobile, consulte
www.nokia.kodakmobile.com/PSHelp.jsp.

También encontrara soporte técnico disponible enviando
un e-mail a support@kodakmobile.com.
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Trabajo

o Seguridad Movil
Symantec m

La Mobile Security Symantec es una solucion de seguridad
para dispositivos méviles que combina antivirus y una
proteccion de cortafuegos y protege su dispositivo contra
contenido perjudicial y ataques dafinos.

s

Para instalar la aplicacion, pulse & y seleccione Trabajo
y el archivo de instalacion de Seguridad Mévil Symantec.
Siga las instrucciones en la pantalla para completar la
instalacion. La aplicacion se instala en la carpeta Trabajo.

Nota: esta aplicacion sélo esta disponible en una
cantidad limitada de idiomas.

La aplicacion es una version de prueba. El periodo de prueba
inicia cuando instala la Mobile Security Symantec. Para
continuar usando la aplicacion después del periodo de prueba,
utilice el servicio LiveUpdate para comprar una actualizacién
de un producto y siga las instrucciones en la pantalla.

La aplicacion se ejecuta en segundo plano mientras utiliza
su dispositivo y automaticamente escanea archivos para

buscar virus cuando éstos son recibidos. Para escanear su
dispositivo manualmente, seleccione Opciones > Escanear.

En caso de encontrar un archivo infectado, aparece una
nota y puede seleccionar que desea hacer con el archivo.

El cortafuegos rastrea conexiones desde y hacia el dispositivo
y registra conexiones desautorizadas. Para ver el registro,
seleccione Opciones > Registro de actividad.

Actualice su dispositivo con los archivos de las mas recientes
definiciones para virus y actualizaciones de producto al
seleccionar Opciones > LiveUpdate. Para actualizar manual-
mente, seleccione los elementos deseados y Opciones >
Buscar. Para programar actualizaciones automaticas y
recordatorios, seleccione Opciones > Configuraciones.

Para usar el servicio de actualizacion, necesita un punto de
acceso a Internet configurado en su dispositivo. Para obtener
mas informacion sobre puntos de acceso, consulte el manual
del usuario de su dispositivo.

Mas informacion

Para abrir la ayuda de la aplicacion, seleccione Opciones >
Ayuda.

Para obtener mas informacion, consulte
www.symantec.com/techsupp.
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@ Quickword m

Quickword para su Nokia N70 admite las funciones mas
comunes de Microsoft Word 97, 2000 y XP y Palm eBooks
en formato .doc. Con Quickword puede leer documentos
originales de Microsoft® Word en la pantalla de su dispositivo.
Quickword admite las modalidades de colores, letras negritas,

letras cursivas, subrayado y de vista completa de pantalla.

Quickword admite documentos guardados en formato
.doc en Microsoft Word 97, 2000 y XP y Palm eBooks
en formato .doc.
Nota: no se admiten todas las variaciones o funciones
de los formatos del archivo mencionados.
Quickword tiene las siguientes propiedades:
® Funciona con PCs compatibles y otros dispositivos Palm
® Almacena documentos en la tarjeta de memoria para
acceso instantaneo

Acceda a los documentos y abralos de las siguientes formas:

e Pulse & y seleccione Trabajo > Quickword. Seleccione
Opciones > Navegar para explorar y abrir documentos
guardados en la memoria del dispositivo y en la tarjeta
de memoria.

® Abra un archivo adjunto de los mensajes de e-mail
recibidos (servicio de red).

® Envie un documento usando la conectividad Bluetooth
a su Buzon entrada en Mensajes.

® Use Adm. arch. para explorar y abrir los documentos
guardados en la memoria del dispositivo y en la tarjeta
de memoria.

* Explore paginas Web. Asegurese de configurar su
dispositivo con un punto de acceso Internet antes
de explorar.

Administrar archivos Word

Pulse & vy seleccione Trabajo > Quickword. Para abrir

un archivo de documento, desplacese a éste y pulse (o).
También puede seleccionar Opciones y alguna de las
siguientes opciones:

Archivos > Organizar: para organizar los archivos en la
pantalla actual por nombre, tamafio, fecha o extension
de archivo.

Archivos > Buscar: para buscar archivos solo en Buzon de
correo o en todas las carpetas de la memoria del dispositivo
y tarjeta de memoria.

Detalles: para ver el tamafio del archivo actual y ver cuando
fue su ultima modificacion.

Ver documentos Word

Para abrir un documento Word y verlo, pulse & y seleccione
Trabajo > Quickword. Seleccione el documento y pulse (e).
Use la tecla de desplazamiento para moverse en el
documento.



Para buscar el documento por texto, seleccione Opciones >
Buscar > Opciones.

También puede seleccionar Opciones y alguna de las
siguientes opciones:

Ir a: para ir al principio, dentro de la posicion seleccionada
o al final del documento.

Zoom: para alejar o acercar.

Autodesplazamiento: para iniciar el desplazamiento
automatico por el documento, pulse (® para detener

el proceso.

Pulse €) para disminuir la velocidad o (@ para acelerar
el desplazamiento automatico.

Mas informacion

En caso de tener problemas con Quickword, consulte
www.quickoffice.com/ para obtener mas informacion.

También encontrara soporte disponible enviando un e-mail
a supportS60@quickoffice.com.

@ Quicksheet m

Quicksheet para su Nokia N70 admite las funciones mas
comunes de Microsoft Excel 97, 2000, 2003 y XP. Con
Quicksheet puede recibir archivos Excel y leerlos en la
pantalla de su dispositivo.

Quicksheet admite los archivos de hojas de calculo guardados

en formato .xIs en Microsoft Excel 97, 2000, 2003 y XP.
Nota: no se admiten todas las variaciones o funciones
de los formatos del archivo mencionados.

Quickword tiene las siguientes propiedades:

e Alterne entre dos hojas de calculo con sélo dos clics.

® Busque un texto dentro de un valor o formula de la hoja
de calculo.

® Cambie el tamafio de columnas e inmovilice e celdas
y columnas.

* Almacene hojas de calculo en la tarjeta de memoria
para acceso instantaneo

Acceda a los documentos y abralos de estas formas:

e Pulse & y seleccione Trabajo > Quicksheet. Seleccione
Opciones > Navegar para explorar y abrir documentos
guardados en la memoria del dispositivo y en la tarjeta
de memoria.

® Abra un archivo adjunto de los mensajes de e-mail
recibidos (servicio de red).

® Envie un documento usando la conectividad Bluetooth
a su Buzon entrada en Mensajes.

® Use Adm. arch. para explorar y abrir los documentos
guardados en la memoria del dispositivo y en la tarjeta
de memoria.

® Explore paginas Web. Asegurese de configurar su
dispositivo con un punto de acceso Internet antes
de explorar.
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Administrar las hojas de calculo

Pulse & vy seleccione Trabajo > Quicksheet. Para abrir un
archivo de hoja de célculo, desplacese a éste y pulse (o).
También puede seleccionar Opciones y alguna de las
siguientes opciones:

Archivos > Organizar: para organizar los archivos en pantalla
actual por nombre, tamaiio, fecha o extension de archivo.
Archivos > Buscar: para buscar archivos solo en Buzon de
correo o en todas las carpetas de la memoria del dispositivo
y tarjeta de memoria.

Detalles: para ver el tamafio del archivo actual y ver cuando
fue su ultima modificacion.

Ver las hojas de calculo

Para abrir una hoja de calculoy verla, pulse & vy seleccione
Trabajo > Quicksheet. Seleccione el archivo de hoja de
calculo y pulse (o).

Use la tecla de desplazamiento para moverse en la hoja
de calculo.

Para alternar entre hojas de calculo, seleccione Opciones >
Ir a, desplacese hacia la hoja y seleccione Aceptar.

Para buscar un texto dentro de un valor o formula de la
hoja de célculo, seleccione Opciones > Buscar > Opciones.
Para cambiar la forma de mostrar la hoja de calculo,
seleccione Opciones y cualquiera de las siguientes opciones:

Camb. tamafio pant.: para alternar entre los modos de
pantalla completa y pantalla parcial.

Nivel de zoom: para acerca o alejar.

Inmovilizar: para mantener visible |a fila o columna resaltada
0 ambas, mientras se mueve sobre la hoja de calculo.
Ajustar ancho col.: pulse ®) o (@ para hacer una columna
mas ancha o mas estrecha. Cuando la columna tenga el
ancho deseado, pulse (o).

Mas informacion

En caso de tener problemas con Quickword, consulte
www.quickoffice.com/ para obtener mas informacion.

También encontrara soporte disponible enviando un e-mail
a supportS60@quickoffice.com.

@ Quickpoint m

Quickpoint para su Nokia N70 admite las funciones mas
comunes de Microsoft Powerpoint 97, 2000 y XP. Con
Quickpoint puede recibir presentaciones PowerPoint
y leerlas en la pantalla de su dispositivo.
Quickpoint admite las presentaciones creadas en formato
.ppt en Microsoft Powerpoint 97, 2000 y XP.
Nota: no se admiten todas las variaciones o
funciones de los formatos del archivo mencionados.
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Quickpoint tiene las siguientes propiedades:

® Vista avanzada con cuatro vistas: esquema, notas del
orador, diapositiva y miniaturas (four-up).

® Almacenamiento de documentos en la tarjeta de memoria
para acceso instantaneo

Acceda a los documentos y abralos de las siguientes formas:

e Pulse & yseleccione Trabajo > Quicksheet. Seleccione
Opciones > Navegar para explorar y abrir documentos
guardados en la memoria del dispositivo y en |a tarjeta
de memoria.

® Abra un archivo adjunto de los mensajes de e-mail
recibidos (servicio de red).

® Envie un documento usando la conectividad Bluetooth
a su Buzon entrada en Mensajes.

® Use Adm. arch. para explorar y abrir los documentos
guardados en la memoria del dispositivo y en la tarjeta
de memoria.

* Explore paginas Web. Asegurese de configurar su
dispositivo con un punto de acceso Internet antes
de explorar.

Administrar las presentaciones
Pulse & y seleccione Trabajo > Quicksheet.

También puede seleccionar Opciones y alguna de las
siguientes opciones:

Archivos > Organizar: para organizar los archivos en pantalla
actual por nombre, tamafio, fecha o extension de archivo.
Archivos > Buscar: para buscar archivos s6lo en Buzén o en
todas las carpetas de la memoria del dispositivo y tarjeta
de memoria.

Detalles: para ver el tamafo del archivo actual y ver cuando
fue su ultima modificacion.

Ver presentaciones

Para abrir una presentacion para ver, pulse & vy seleccione
Trabajo > Quickpoint. Desplacese a una presentacion

y pulse (®.

Para moverse entre las vistas Esquema, Notas, Diapositiva
y Miniatura, pulse ) o (9.

Pulse (g) o (®) para pasar a la diapositiva siguiente o anterior
durante la presentacion.

Para cambiar entre el modo de pantalla completa y pantalla
parcial, seleccione Opciones > Camb. tamaio pant..

Para expandir o contraer elementos en el esquema de la
presentacion en la vista esquema, seleccione Opciones >
Esquema.

En la vista diapositiva en el modo de pantalla completa, pulse:

® 1—para alejar
® 2-—para acercar
® 3—para ajustar la diapositiva en la pantalla

Trabajo
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Mas informacion

En caso de tener problemas con Quickpoint, consulte
www.quickoffice.com/ para obtener mas informacion.

También encontrara soporte disponible enviando un e-mail
a supportS60@quickoffice.com.

ﬂ Adobe Reader m

Con Adobe Reader, puede leer los documentos PDF en la
pantalla de su dispositivo.

(s

Nota: esta aplicacion fue optimizada para el
contenido de documentos PDF en teléfonos y otros
dispositivos maviles y provee sélo un conjunto
limitado de funciones comparado con las
versiones PC.

Nota: esta aplicacion sélo esta disponible en una
cantidad limitada de idiomas.

(s

Acceda a los documentos y abralos de las siguientes formas:

e Pulse & y seleccione Trabajo > Adobe PDF. Seleccione
Opciones > Buscar archivo para explorar y abrir
documentos guardados en la memoria del dispositivo
y en la tarjeta de memoria.

® Abra un archivo adjunto de los mensajes de e-mail
recibidos (servicio de red).

® Envie un documento usando la conectividad Bluetooth
a su Buzoén entrada en Mensajes.

® Use Adm. arch. para explorar y abrir los documentos
guardados en la memoria del dispositivo y en la tarjeta
de memoria.

* Explore paginas Web. Asegurese de configurar su
dispositivo con un punto de acceso Internet antes
de explorar.

Administrar archivos PDF

Para explorar y administrar archivos PDF, pulse &

y seleccione Trabajo > Adobe PDF. Sus archivos recientes
estan en una lista en la vista archivo. Para abrir un documento,
desplacese a éste y pulse (o).

También puede seleccionar Opciones y alguna de las
siguientes opciones:

Buscar archivo: para explorar por los archivos PDF en la
memoria del dispositivo o en la tarjeta de memoria.

Configuraciones: para modificar el nivel de zoom y el modo
de visualizacion predeterminados de los documentos PDF.

Ver archivos PDF

Cuando un archivo PDF esté abierto, seleccione Opciones
y alguna de las siguientes opciones:

Zoom: para acercar, alejar o cambiar el tamafio a un
porcentaje seleccionado. También puede cambiar el tamafio
segun el ancho de la pantalla o ajustar la pagina PDF
completa en la pantalla.


www.quickoffice.com/
supportS60@quickoffice.com

Buscar: para buscar un texto en el documento.

Ver: para ver el documento en el modo de pantalla completa.
También puede girar el documento PDF a 90 grados hacia
cualquier sentido.

Ir a: para moverse a una pagina seleccionada, siguiente,
anterior, primera o ultima.

Guardar: para guardar el archivo en la memoria del
dispositivo o tarjeta de memoria.

Configuraciones: para modificar el nivel de zoom y el modo
de visualizacion predeterminados.

Detalles: para mostrar las propiedades del documento PDF.

Mas informacion

Para obtener mas informacion, consulte www.adobe.com.

Para compartir preguntas, sugerencias e informacion
sobre la aplicacion, visite el foro para usuario de
Adobe Reader para Symbian OS en
http://adobe.com/support/forums/main.html.

Imprimir informacion m
—

IS

Pulse & vy seleccione Trabajo > Impr info.. La aplicacion
Impr info. le permite imprimir directa e inalambricamente
desde su dispositivo. Puede imprimir una variedad de
contenidos desde su dispositivo en una impresora Basic Print
Profile (BPP) equipada con conectividad Bluetooth (por
ejemplo, HP Deskjet 450 Mobile Printer y HP Photosmart
8150). Los contenidos incluyen mensajes multimedia y de
texto, texto de e-mail, contactos, agenda y notas.
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Nota: esta aplicacion sélo esta disponible en una
cantidad limitada de idiomas.

Para contactos, la aplicacion admite la impresion de los
siguientes campos de contacto: teléfono, fax, mévil, e-mail,
URL Yy direccion.

Mas informacion

Para obtener mas informacion, consulte
www.hp.com/united-states/camphone/mobile print.html.
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8 | Conectividad
2
"8' TECIadO |na|émbrico ) 6 Para vincular el teclado con su dispositivo, ingrese una
c contrasefia de su eleccion (de uno a nueve digitos) en el
8 dispositivo, ingrese la misma contrasefia en su teclado
Para configurar un Teclado Inaldmbrico Nokia u otro en los siguientes treinta segundos y pulse la tecla de
teclado inaldmbrico compatible que admita el perfil de ingreso en el teclado. No_necesna escribir la contra_seﬁa
dispositivo de interfaz humano (HID) de Bluetooth con su ya que podra usar una diferente en caso de necesitar
dispositivo, use la aplicacion Teclado Inalambrico. El vincular el teclado nuevamente con su dispositivo.
teclado le permite ingresar texto comodamente, usando la Para ingresar los digitos de la contrasefia, podria necesitar
presentacion completa QWERTY, para mensajes de texto, e- pulsar la tecla Fn primero.
mail y entradas de agenda. 7 Sise le solicita una distribucion del teclado, seleccionela
G Nota: esta aplicacion solo esta disponible en una de la lista en su dispositivo.
cantidad limitada de idiomas. 8 Cuando el nombre del teclado aparece, su estado cambia

a Keyboard connected y el indicador verde en su teclado

Active la conectividad Bluetooth en su dispositivo. e
destella lentamente, el teclado esta listo para ser usado.

Encienda el teclado.
Para obtener mas informacion sobre la operacion y

Pulse & vy seleccione Conect. Teclado Inalambrico. .o .
J
mantenimiento de su teclado, consulte el manual del usuario.

A W N =

Seleccione Opciones > Find keyboards para iniciar la
busqueda de dispositivos con conectividad Bluetooth.

5 Seleccione el teclado de la lista.




Personal
@ Catalogos m

Catalogs (servicio de red) es un contenido de compras
moviles disponible en su dispositivo.

Use Catalogs para descubrir, descargar y disfrutar de
contenido, servicios y aplicaciones que funcionan con su
Nokia N70. Juegos, tonos de timbre, imagenes de fondo,
aplicaciones y mucho mas estan a la mano. El contenido
disponible depende de su operador de red y proveedor
de servicios.

o

Configurar catalogos

Pulse & y seleccione Personal > Catalogs. Seleccione
Aceptar si acepta la clausula.

Nota: esta aplicacion sélo esta disponible en una
cantidad limitada de idiomas.

Cuando abra Catalogs por primera vez, se le solicita que
defina las configuraciones.

1 En la barra Network, seleccione el punto de acceso
a usarse para hacer la conexion al servidor de catalogo
y como se muestra el progreso de la descarga.

2 Para configurar sus preferencias, pulse (@ para abrir
la barra General. Seleccione el lugar donde los archivos
temporales seran guardados, si desea que se abra el
contenido automaticamente tras ser descargado y si
desea que el dispositivo solicite su confirmacion antes
de ver la vista previa o descargar contenido.

3 Después de que haya finalizado con las configuraciones,
seleccione Hecho.

La aplicacion actualiza su dispositivo con los catalogos mas
recientes disponibles de su operador de red o proveedor de
servicios y otros canales disponibles. Si desea cambiar las
configuraciones en otro momento, seleccione Options >
Settings.

Catalogs utiliza sus servicios de red para acceder el contenido

de catalogo mas actualizado. Para obtener mas informacién
sobre elementos adicionales disponibles a través de Catalogs,

comuniquese con su operador de red o proveedor de servicios.

Usar catalogos

En la vista principal, puede explorar los catalogos

disponibles en su dispositivo. Con Catalogs, usted puede:

® Descubrir nuevo contenido que esta disponible para
su Nokia N70.
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Personal

® \Ver una vista previa de nuevos elementos y leer sus
descripciones y descargar versiones de prueba (si esta
disponible).

e Comprar de la manera mas facil. Catalogs le ofrece
los métodos de pago disponibles para usted. Catalogs
admite descargas de fondo, descargas de multiples
fuentes e instalacion automatica.

® Actualizacion cuando es necesaria. Su dispositivo
sabe cuando hay actualizaciones disponibles para
las aplicaciones que ha instalado.

Catalogs recibe actualizaciones continuamente, brindandole
el contenido mas reciente que su operador de red o proveedor
de servicios ofrece para su dispositivo. Para actualizar los
catalogos manualmente, seleccione Options > Actions >
Refresh.

@ Explorador Opera m

Para acceder a la Web, pulse & y seleccione Personal.
Con el explorador Opera, puede acceder a paginas que usan
el lenguaje extensible de marcado de hipertexto (XHTML),
lenguaje de marcado de hipertexto (HTML), el lenguaje
extensible de marcado (XML) o lenguaje de marcado de
telefonia inalambrica (WML).

g Nota: esta aplicacion sélo esta disponible en una
cantidad limitada de idiomas.

Para obtener mas informacién sobre disponibilidad de
servicios, precios y tarifas, consulte a su operador de red o
proveedor de servicios. Los proveedores de servicios también
le daran las instrucciones sobre el uso de sus servicios.

Para acceder a la Web, necesita un punto de acceso a
Internet configurado en su dispositivo. Para obtener mas
informacion sobre puntos de acceso, consulte el manual
del usuario de su dispositivo.

Explorar la Web

G Importante: use solo los servicios fiables y que
ofrecen seguridad adecuada y proteccion contra
software perjudicial.

Cuando tenga las configuraciones de conexion adecuadas
en su dispositivo, podra acceder a la Web. Pulse & y
seleccione Personal > www. Para abrir una pagina Web,
pulse 1 para abrir un campo para ingresar la direccion
URL o pulse 2 para ver favoritos.

El explorador Opera formatea paginas Web disefiadas para
la exploracion con una PC para que se ajuste al ancho de
la pantalla del dispositivo (ajustar al modo pantalla). Para
moverse en la pagina, desplacese hacia arriba o abajo. Para
seleccionar elementos en la pagina, como enlaces, botones
o campos de formularios, desplacese hacia la izquierda o
derecha para moverse al elemento y pulse (®). En algunas
paginas disefiadas para teléfonos maviles, el desplazarse
en cualquier direccion selecciona elementos.



Para ver paginas en su disefio original, pulse #. Para moverse
en la pagina, use la tecla de desplazamiento. Para seleccionar
elementos en la pagina, seleccione Focus, desplacese al
elemento y pulse (). Para desplazarse en la pagina
nuevamente, seleccione Scroll. Para regresar a ajustar

al modo pantalla, pulse #.

Para ver paginas en pantalla completa, pulse la tecla *.
Para regresar a la vista normal, pulse la tecla * nuevamente.

Para retroceder a la pagina anterior durante la exploracion,
pulse Atras.

Para guardar un favorito para la pagina actual, pulse 7.

Puede descargar archivos que no pueden ser vistos en
la pagina del explorador, como temas y videoclips. Para

descargar un elemento, desplacese hacia el enlace y pulse (o).

G Importante: instale y utilice sélo aplicaciones
y software de fuentes que brinden seguridad y
proteccion adecuada contra software perjudicial.

Las protecciones de copyright pueden impedir la copia,
modificacion, transferencia o desvio de imagenes, musica
(incluyendo tonos de timbre) y otro contenido.

Para cambiar configuraciones de pantalla, general o
avanzadas, seleccione Opciones > Configuraciones.

Finalizar la conexion

Para finalizar la conexion o cerrar el explorador, seleccione
Opciones > Salir.

Vaciar la memoria caché

La memoria caché es una parte de la memoria que se emplea
para guardar datos en forma temporal. Si ha intentado
acceder o ha accedido informacion confidencial que exige
contrasefas, vacie la memoria caché del teléfono después de
cada uso. La informacion o servicios a los que ha accedido se
almacenan en ella. Para vaciar la memoria caché, seleccione
Options > Tools > Delete private data > Delete cache.

Mas informacion

Para ayuda adicional sobre el uso de las funciones,
seleccione Opciones > Herramientas > Ayuda.

Consulte www.opera.com/support/tutorials/s60/ para
obtener mas informacion.
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Herramientas

& Asistente de
configuracion m

SettingWizard programa su dispositivo para
configuraciones de e-mail y operador (MMS, GPRS e

Internet) basados en la informacion de su operador de red.

G Nota: para usar estos servicios, debera comunicarse
con su operador de red o proveedor de servicios
para activar una conexion de datos u otros
servicios.

Pulse & vy seleccione Herram. > SettingWizard.

Del menu, seleccione el elemento que desea configurar en
su dispositivo y pulse (®.

E-mail

1 Cuando opta por ajustar sus configuraciones de e-mail
Settings Wizard detecta su operador de red disponible
y le solicita que lo confirme. Seleccione Aceptar o
desplacese a otro operador de red y seleccione Aceptar.

2 Seleccione su proveedor de servicios de e-mail de la
lista.

3 Seleccione el servidor de correo saliente. Use el
servidor predeterminado si no esta seguro.

4 Settings Wizard le solicita que ingrese los datos de su
direccién de e-mail, nombre de usuario y contrasefa.
Seleccione cada uno a su vez y seleccione Opciones >
Cambiar. Ingrese los detalles y seleccione Aceptar.

5 Seleccione Opciones > Aceptar cuando termine.

Seleccione Aceptar para confirmar su deseo de configurar
el buzon de correo para el operador en particular.

7 Seleccione Aceptar.

Operador

1 Cuando opta por ajustar sus configuraciones de operador,
Settings Wizard detecta su operador de red disponible
y le solicita que lo confirme. Seleccione Aceptar o
desplacese a otro operador de red y seleccione Aceptar.

2 Seleccione Aceptar para confirmar su deseo de
configurar su dispositivo para el operador especificado.

Mas informacion

En caso de tener problemas con SettingWizard, consulte
el sitio Web de configuraciones de teléfonos Nokia en
http://latinoamerica2.ext.nokia.com/configuraciones.



http://latinoamerica2.ext.nokia.com/configuraciones

Mobile Search
& Mobile Search m

Use Mobile Search para tener acceso a las herramientas de
busqueda lideres. Una manera sencilla, comoda y rapida
para buscar y conectarse a servicios locales, sitios Web,
imagenes y contenido mévil. Puede buscar y llamar a
restaurantes locales y tiendas y usar la tecnologia de
mapa avanzada para que lo guie a su ubicacion.

Use Mobile Search

Pulse & vy seleccione Search.

G Nota: la disponibilidad de este servicio puede
variar de acuerdo a su pais o area de ventas.

Cuando abre Mobile Search, aparece una lista de categorias.
Seleccione una categoria (por ejemplo, imagenes) e ingrese
su texto dentro del campo de busqueda. Seleccione Search
y aparecen los resultados.

Mas informacion

Para obtener ayuda adicional sobre las funciones del
programa, seleccione Opciones > Help.

Para obtener mas informacion, consulte
www.mobilesearch.nokia.com.
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www.mobilesearch.nokia.com

Yahoo! Go

Yahoo! Go

! Yahoo! Go m

YAHOO! GO

Acceda a su e-mail, albumes de fotos, mensajeria instantanea
y mas, desde donde esté. Manténgalo facil, manténgalo
seguro y mantenga su tranquilidad. Con Yahoo! Go, puede
estar afuera y sequir conectado con su cuenta jYahoo!

Q Nota: algunas aplicaciones sélo estan disponibles
en una cantidad limitada de idiomas.

Yahoo! Go, le permite acceder a servicios incluyendo Correo
Yahoo!, Messenger Yahoo!, Fotos Yahoo!, Busqueda Yahoo!,
asi como ver noticias y descargar juegos y tonos de timbre.

Yahoo! Go, usa una funcién de conexién individual, lo que
significa que sdlo necesita registrarse una sola vez durante
la programacién.

Yahoo! Go, consta de las siguientes cuatro funciones
principales:

® Correo Yahoo!

® Messenger Yahoo!

® Conexiones Yahoo!

® Fotos Yahoo!

Correo Yahoo!

Con Correo Yahoo! puede obtener sus e-mails cuando esta
en movimiento. La sincronizacion automatica con su cuenta
de Correo Yahoo! asegura que todo lo que realiza en su
dispositivo (por ejemplo, el envio de e-mails, marcar e-mails
como leidos o eliminar e-mails) se refleja inmediatamente
en su cuenta Yahoo! en linea.

Messenger Yahoo!

Messenger Yahoo! le permite charlar con sus contactos
usando su dispositivo. Puede enviar y recibir texto de
mensajes instantaneos (IMs), emoticones, audibles, mensajes
de voz instantaneos, adjuntar imagenes a mensajes
instantaneos y administrar su cuenta de Messenger Yahoo!

Para aparecer conectado para sus contactos, necesita
registrarse en Messenger Yahoo! haciendo un clic. Su
dispositivo guarda su informacion de conexion de tal manera
que no necesite ingresarla cada vez que desee conectarse
a mensajeria instantanea. En forma predeterminada
permanecera conectado en Messenger por un maximo

de diez minutos cada vez que su dispositivo sea detectado
como inactivo. Aumentar la duracion de tiempo para esta
configuracion reducira el tiempo standby de su dispositivo.



Algunas redes no admiten el uso simultaneo de Messenger
Yahoo!y la recepcion de [lamadas de video y mensajes
multimedia (MMS).

Conexiones Yahoo!

Conexiones Yahoo! sincronizan su dispositivo y su cuenta
Yahoo!

Conexiones Yahoo! inicia automaticamente cada vez que
enciende su dispositivo. No necesita abrir el explorador
para ver e-mails y otra informacion Yahoo!. También puede
enviar e-mail desde su cuenta de Correo Yahoo!y ver, crear,
editar y eliminar contactos, eventos de agenda y tareas
usando las aplicaciones de mensajeria, contactos y agenda
en su dispositivo. Los cambios que haga se reflejan en su
cuenta Yahoo!

Conexiones Yahoo! muestra el estado de la ultima conexion,
lograda o no, y si un intercambio de informacion esta
actualmente llevandose a cabo. También muestra las
horas del ultimo y préximo intercambio de informacion
programado.

Fotos Yahoo!

Fotos Yahoo! le ayuda a administrar y compartir sus fotos.
Fotos Yahoo! en su dispositivo le permite ver y descargar
imagenes desde su dispositivo, asi como enlazarse a Fotos
Yahoo!y ver sus albumes en la Web. La funcién se ejecuta
conjuntamente con Conexiones Yahoo!

Cada vez que toma una foto con su dispositivo, Fotos Yahoo!
le pregunta si desea agregarla en su album. Las fotos que
carga a Fotos Yahoo! aparecen:
e Ensu album en el sitio Web de Fotos Yahoo! (en su
tamario original).
® En la aplicacion de Fotos Yahoo! en su dispositivo
(en un tamafio reducido).
e En la Galeria del dispositivo (en el tamafio original)

Mas informacion

Para obtener mas informacion sobre Yahoo! Go, su
funcionamiento, informacion de costos y ayuda adicional,
consulte: www.yahoo.com/ (texto en inglés).

Yahoo! Go
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Para su PC
%’ Lifeblog m ©

Nokia Lifeblog es una combinacion de software para teléfono
movil y PC que mantienen un diario multimedia de los
elementos que colecciona en su dispositivo. Lifeblog organiza
automaticamente sus fotos, videos, mensajes de texto y de
multimedia y registros Web publicados con una cronologia
por la cual se puede explorar, hacer una busqueda, compartir,
publicar y hacer copias de seguridad. Ambos Lifeblog para PC
y Lifeblog para teléfono movil le permiten enviar o hacer blog
de sus elementos para que otros usuarios los vean.

Lifeblog para teléfono mévil automaticamente mantiene
un registro de sus elementos multimedia. Use Lifeblog en su
dispositivo para explorar por sus elementos, enviarlos a otros
o publicarlos en la Web. Conecte su dispositivo a una PC
compatible usando un cable USB o conectividad Bluetooth
para transferir y sincronizar los elementos en el dispositivo
consu PC.

Lifeblog para PC facilita una facil exploracion y busqueda
de los elementos que ha coleccionado con su dispositivo.
A través de un boton de transferencia y un cable de datos
USB o conectividad Bluetooth, sus fotos, videos, mensajes
de texto y mensajes de multimedia favoritos se transfieren
nuevamente a su dispositivo.

Para proteccion, puede usar copias de sequridad de su base

de datos Lifeblog usando su disco duro, CDs, DVDs, unidad

extraible o unidad de red. Ademas, puede publicar elementos

en su registro Web (blog).

B Nota: esta aplicacion sélo esta disponible en una
cantidad limitada de idiomas.

Instalar Lifeblog en su dispositivo m

Para instalar Lifeblog en su dispositivo:

1 Pulse & vy seleccione Visual > Lifeblog.

2 Seleccione Opciones > Abrir para iniciar el programa
de instalacion.

3 Pulse Aceptar para instalar la aplicacion Lifeblog en
el teléfono. Lifeblog se instala en la carpeta Visual.

Instalar Lifeblog en su PC (©

Antes de instalar Lifeblog en una PC compatible, necesitara

lo siguiente:

® 1 GHz Intel® Pentium® o equivalente, 128 MB RAM

e 400 MB de espacio disponible en el disco duro (si se
debe instalar Microsoft® DirectX® y Nokia PC Suite)

® (apacidad de graficos de tamafio1024x768 y 24 colores

® Tarjeta de graficos de 16 MB

¢ Microsoft® Windows® 2000 o Windows XP.



Para instalar Lifeblog en su PC.

1 Inserte el CD-ROM suministrado con su dispositivo.

2 |Instale Nokia PC Suite (incluso los controladores para
el cable USB CA-53).

3 Instale Nokia Lifeblog para PC.

4 Si Microsoft® DirectX® 9.0 no ha sido instalado en su PC,
se instala ahora.

Conectar su dispositivo y su PC

Para conectar su dispositivo y una PC compatible usando

el cable USB:

1 Asegurese de que haya instalado Nokia PC Suite y el
controlador CA-53 para la conexion USB.

2 Conecte el cable USB al dispositivo y la PC.

3 Inicie la aplicacion PC del Lifeblog.

Para conectar su dispositivo y una PC compatible usando

la tecnologia inalambrica Bluetooth:

1 Asegurese de que tiene instalado en su PC el Nokia PC
Suite.

2 Active la conexion Bluetooth en su dispositivo y en su PC.
Para obtener mas detalles, consulte el manual del usuario
para su dispositivo y la documentacién para su PC.

Transferir elementos

Cuando haya conectado su dispositivo a una PC compatible
usando un cable USB o la conectividad Bluetooth, esta listo
para transferir sus elementos.

Para transferir elementos de su dispositivo Timeline a |a vista

Timeline en la PCy para sincronizar su Timeline:

1 Inicie la aplicacion Lifeblog en su PC.

2 En la aplicacion Lifeblog PC, seleccione File >
Transfer items.

Los elementos en el dispositivo los cuales fueron transferidos

con éxito a la PC se eliminan de su dispositivo. Los elementos

se eliminan de todos los puntos donde se almacenan en el

dispositivo (por ejemplo, Mensajes y Galeria). Si no desea que

sus elementos se eliminen del dispositivo, agréguelos a sus

Favoritos antes de transferirlos a la PC. Los favoritos y

mensajes de texto siempre se mantienen en su dispositivo,

a menos que usted especifique lo contrario.

Publicar en la Web

Para compartir sus mejores elementos Lifeblog, envielos

a su registro Web en la Internet para que otros los vean.

Primero debe crear una cuenta con un servicio de registro

Web, crear uno o mas registros Web que usara como el

destinatario de sus anuncios y agregar la cuenta de registro

Web al Lifeblog. El servicio de registro Web recomendado

para Lifeblog es www.typepad.com de Six Apart.

En su dispositivo, agregue la cuenta de registro Web en

Lifeblog en las configuraciones registro Web. En su PC,

edite cuentas en la ventana Edit weblog accounts.

Para publicar elementos en la Web desde su dispositivo:

1 En Timeline o Favorites, seleccione los elementos que
desea publicar en la Web.

Para su PC


www.typepad.com
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Seleccione Opciones > Post to Web.
Si usa la funcion por primera vez, Lifeblog recupera una

lista de registro Web desde el servidor de registro Web.

Se abre el didlogo de publicacion de registro Web.
Seleccione el registro Web deseado de la lista Post to:. Si
ha creado nuevos registros Web, para actualizar |a lista de
registro Web, seleccione Opciones > Refresh weblog list.
Ingrese un titulo y descripcion para la publicacion.
También, puede escribir un texto o una descripcion
mas larga en el campo del texto principal.

Cuando tenga todo listo, seleccione Opciones > Enviar.

Para publicar elementos en la Web desde su PC:

1

4
5

En Timeline o Favoritos, seleccione los elementos
(cincuenta maximo) que desea publicar en la Web.

Seleccione File > Post to Web... 0 haga clic en el boton
Post to the Web. Se abre la ventanilla Post to Web.
Ingrese un titulo y descripcion para la publicacion.
También, puede escribir un texto o una descripcion mas
larga en el campo del texto principal.

Seleccione el registro Web deseado de |a lista Post to:.
Cuando tenga todo listo, haga clic en el botén Enviar.

Importar elementos del disco duro,
CD o DVD

Ademas de las imagenes .jpg en su dispositivo para
visualizacion, puede también importar imagenes .jpg

y videoclips.3gp y .mp4 de otras fuentes (como un CD
o carpetas en su disco duro) dentro de Lifeblog.

Para importar imagenes o videos desde una PC al Lifeblog
para la PC:

1

En la vista Timeline o vista de favoritos, seleccione File >
Import from PC.... Se abre la ventanilla Import images or
videos from your PC.

Explore por la lista para encontrar la carpeta de imagen
o de video de la lista o explore por las otras carpetas
para encontrar el archivo deseado. Use la lista Look in
para explorar otras unidades o dispositivos.
Seleccione una carpeta, archivo o varios archivos.
Puede ver su contenido en la ventanilla Preview.

Haga clic en Import para importar la carpeta
(incluyendo subcarpetas) o archivos seleccionados.

Explorar las vistas Timeline y Favoritos

en su PC

Cuando inicie Lifeblog en su PC, hay varias formas de moverse
por las vistas Timeline y Favoritos. La forma mas rapida es
agarrando el mango del deslizador y moverlo hacia adelante
0 atras, rapido o lento. Alternativamente, haga clic en la
barra de tiempo para seleccionar una fecha, usar la funcién
Ir a fecha o usar las teclas de flechas.



Mas informacion

Para obtener mas informacién sobre servicios de registro
Web y su compatibilidad con Lifeblog, consulte
www.nokia.com/lifeblog o pulse F1 en la aplicacion
Lifeblog PC para abrir Lifeblog Help.

Para obtener su codigo de licencia gratuito para propietarios
del dispositivo serie N de Nokia, consulte en
www.nokia.com/nseries/lifeblog.

PC Suite ©®

Nokia PC Suite es un conjunto de aplicaciones PC
desarrolladas para su uso en su Nokia N70.

Para instalar y usar Nokia PC Suite, necesita una PC que
funcione con Microsoft® Windows 2000 o XPy sea compatible
con el cable USB provisto o con la conectividad Bluetooth.
Antes de usar Nokia PC Suite, debera instalarlo en su PC.
Consulte el CD-ROM para obtener mas informacion.

Una guia del usuario mas completa para PC Suite esta
disponible en formato electronico en el CD-ROM.

Conectar su dispositivo a la PC

El asistente Get Connected le ayuda a conectar su dispositivo
a una PC compatible. Una vez finalizados los pasos del
asistente, la conexion entre su dispositivo y la PC ha sido
establecida y puede usar las aplicaciones del Nokia PC Suite
que requieren de la conectividad PC.

1 Instale Nokia PC Suite. Get Connected se abre
automaticamente.

2 Seleccione el tipo de conexion a usar cuando conecte
el dispositivo a la PC.

3 Siga las instrucciones en la pantalla para conectar
el dispositivo a la PC.

Para abrir Get Connected en otro momento (por ejemplo,

para configurar otro tipo de conexion), seleccione Get

Connected en Nokia PC Suite.

Sincronizar

Nokia PC Sync le permite sincronizar los contactos, la agenda,

notas de tarea y elementos de notas entre su dispositivo

y una PC Personal Information Manager (PIM) compatible,

permitiéndole mantener actualizados los datos en su

dispositivo y PC.

1 Inicie Nokia PC Suite.

2 Conecte su dispositivo a la PC usando el cable USB

o la conexion Bluetooth.

3 Seleccione Sincronizar en Nokia PC Suite.

Q Nota: al hacer la conexion por primera vez, un
asistente le ayuda a configurar el modo
predeterminado de sincronizacion.

Puede configurar el dispositivo y la PC para que sincronicen

automaticamente los datos cuando el dispositivo esta

conectado a la PC y Nokia PC Suite esta activado.

Para su PC
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Hacer copias de sequridad y restaurar
Haga copias de seguridad desde su dispositivo o restaure
datos guardados de la PC compatible al dispositivo.
1 Inicie Nokia PC Suite.
2 Conecte su dispositivo a la PC usando el cable USB
o la conexion Bluetooth.
3 Seleccione Copiar y restaurar en Nokia PC Suite.
4 En la pagina Seleccionar una tarea, seleccione Realizar
una copia de seguridad o Restaurar datos.
5 Siga las instrucciones en la pantalla.
Se recomienda que haga copias de seguridad del contenido
de su dispositivo periédicamente para evitar la posible
pérdida de datos.

Guardar imagenes y videoclips

Con Image Store, podra guardar imagenes y videos desde su
dispositivo a una PC compatible. La aplicacion verifica la
memoria del dispositivo y la tarjeta de memoria para buscar
nuevas imagenes y videos que han sido capturados desde la
ultima sesién de almacenamiento y los guarda en la PC.
Las protecciones de copyright pueden impedir la copia,
modificacion, transferencia o desvio de imagenes, musica
(incluyendo tonos de timbre) y otro contenido.

1 Inicie Nokia PC Suite.

2 Conecte su dispositivo a la PC usando el cable USB
o la conexion Bluetooth.

w

Seleccione Almacenar imagenes en el Nokia PC Suite.
Cuando utiliza Image Store por primera vez, un asistente
de configuraciones se abre. Debera completar las
configuraciones para poder guardar archivos desde su
dispositivo a la PC. Siga las instrucciones en la pantalla.
5 Seleccione Almacenar ahora en la ventana principal de
Image Store. Image Store busca la memoria del dispositivo
y tarjeta de memoria para nuevas imagenes y videos
capturados desde la ultima sesién de almacenamiento.
Dependiendo de los t